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1.0 Introduction

Monitor and Configuration Software

Weschler monitor, configuration and flash software, referred to in this manual as AMTCMF software, is designed to allow
users to fully exploit the measurement capability and programmability of the Enhanced Advantage product line. The
software runs on computers which run the Microsoft Windows operating system and have an available serial comm port.
It has been run successfully on platforms loaded with Windows 95, 98, 98SE, 2000, XP, Vista and 7. The software is
included with the communications feature. The software is composed of four modules, configuration, monitor, firmware
update and log file utility.

The configuration module allows users to compose a complete set of configuration parameters  at any time and download
them immediately, or store them for use at a later date, at their convenience. The files can be uploaded locally from a
portable computer or remotely through the utility’s intranet. The configuration files which are generated are very compact
text files, typically less than 20 KB in size. This makes maintenance and storage of Advantage configuration files, for even
the largest inventory of transformers, an easy task.

The text files generated by the configuration module must not be edited and saved by a word processor. They may be
viewed and printed from a word processor but not saved. In order to preserve the formatting of the printed file, the font
settings for the word processor must be the same as for the AMTCMF software. The software’s default font is Courier New,
9 point.  In order to protect the file from inadvertent editing, It is suggested that the user set the attributes of the file to read
only, once its content is satisfactory.

The monitor module allows users to remotely view thermal conditions which an Advantage is measuring, and reset peak
and valley values at any time. The status and configuration settings of alarms and cooling control relays are also tabulated.
The user is also able to remotely test or exercise relays and equipment under the Advantage’s control.

The firmware update module allows users to replace the firmware and send special discreet configuration commands.  The
logged data file utility provides for retrieval, formatting and graphical display of log files that are stored in flash memory. 

Applicability

This version of AMTCMF software can coexist on the same computer with any configuration or monitor software from  First
Generation (FirstGen) or ColdFire (IIR) Advantage models. If running an AMTCMF software for the Enhanced (IIE) model
series, the old software must be removed prior to loading the new version.

This version of AMTCMF software is identified by the code AMTCMF02XX, where the XX represents the version number.
The AMTCMF software is model-independent, which means that it will work with most IIR and all IIE models having
firmware versions dated after 4/08/2009. To determine if your Advantage meets this requirement, scroll to the Advantage’s
front panel firmware display and read the firmware code screen. Compare the code to the CMF software’s system screen.
See plates 16 & 17 of this manual. If the firmware code is anything other than the ones listed on the system screen, you
cannot use this version of AMTCMF software. Contact Weschler Marketing for details regarding availability of a firmware
upgrade. The install process is identical for all IIE models.

Firmware Installation (flashing) Method

The flash and log file utility allows the user to upgrade the Advantage’s operating firmware from inside the AMTCMF
package, without needing to use a third party TFT communications program. This method only requires that the operator
remove the terminal cover and plug an interface cable (see section 6 for cable details) into the Advantage and host PC.
The firmware is then uploaded in a painless process that takes under three minutes at a bit rate of 115.2 Kb/s, using an
RS-232 or RS-422/485 4-wire connection. The firmware can be upgraded using a TFT program such as HyperTerminal,
however; this method presents a great deal of risk of damaging the Advantage beyond field recovery. This is because
HyperTerminal will transfer any file without first checking if it is a valid and undamaged file. The AMTCMF software contains
protective algorithms to ensure that the file being transferred is both valid and uncorrupted.

Peak and Valley Log File Download

The logged data file utility allows for download of peak and valley log files that are stored in memory. 
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2.0 AMTCMF Software Installation

Preparation to Install

All models in the Advantage II Enhanced series in the AMTSYS020X firmware series use the same AMTCMF software.
This means the process for installing software to, or removing software from your PC is the same regardless of whether
you are doing the process for a CT/LTC or CT or TC or any other model in the Enhanced Advantage II family.

If you already have a version of the AMTCMF01XX or 02XX software loaded and you are upgrading to a higher revision
level, you must first remove the currently loaded version, using the procedure of plates 1 to 4 below. The graphics shown
depict Windows XP operations. Windows 7 operates in a similar manner. If you do not have one of these versions installed,
skip down to plate 5.

Removal of Older AMTCMF Software Versions

   

Plate 2. Double click on the Add or Remove
Programs icon. In Windows 7 an “Uninstall
Program” option will be offered.

Plate 1. Click Start>Control Panel

Plate 3. Click on the software you want to remove, then click “Add/Remove”. You cannot remove more than one
program at a time. If you want to remove more than one program, you will need to return to this screen again. The
software name highlighted here, AMT Launch Pad, is the name that will be displayed for this version of AMTCMF
software. Earlier AMTCMF software will be named “Advantage Configuration, Monitor and Flash” or “Transformer
Advantage 2.00". In Windows 7, you can either right-click the selection then left click the pop-up “change/uninstall”
button or after selection of AMT launch Pad, click the “change/uninstall” button on the address bar.
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Plate 4. When you click the Yes button the old program will be removed. If
you have navigated here in error, click the No button.

Plate 6. Click the Browse button and navigate to the directory
which contains the setup.exe file for the Advantage model of
interest. Click “Open” to send the file location of the setup.exe
file to the Run dialog box.

Windows 7. Using Windows Explorer, navigate to the directory
that contains the AMTCMF02xx software and double-click the
setup.exe file. This will launch the installer. Skip to plate 8.

Plate 7. Click the OK Button to initiate the
installation program

Plate 5. Click Start>Run to open the browse
dialog box.

Windows 7 users skip to plate 6.

AMTCMF Software Installation

If any Windows programs are running, they should be terminated before running the set up software
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Plate 12. Select the program group that you
want the software to appear in. We suggest
accepting the default. Click the continue
button to close the box.

Plate 11. Click the computer icon to continue with the
installation.

Plate 8. If no Windows Programs are running, click OK,
otherwise click Exit Setup and close any running
Programs.

Plate 10. Browse to the directory into which you
want the software to install and click OK.

Plate 9. If you are satisfied with the directory the setup
program has selected, skip to plate 11. We strongly
suggest accepting the default directory. Otherwise, click
Change Directory.

Plate 13. The software installation will be
successfully completed when this dialog box
appears. Click the OK button to close the box.
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Plate 14. The launch pad screen will open. It is not necessary to have a unit connected to create or edit a configuration
file or view the monitor module’s features. If a unit is not available, simply click the model type drop-down button, then
scroll  to and click the desired model in the list box.

3.0 Software Operation

Either double-click the “AMT Launch Pad” desktop icon or navigate to and click on the “AMT Launch Pad” menu item in
the Weschler Advantage program group, from the start > all programs menu.

Unit ID
Window

Model Type
Window

Connection Names
List

Exit
Button

System
Connectivity
Information
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Plate 15. The configuration module(s) are
capable of creating or editing files from
earlier vintage Advantage models. Once
the model has been selected, the firmware
version of the earlier model can be
selected. This will ensure compatibility of
the created file with the earlier model.
Consult the “Applicability” paragraph in the
introduction for firmware numbering. Once
the model and firmware information has
been entered, the configuration module’s
launch button can be clicked to open the
configuration screen (see plates 37 & 38).
The monitor module can also be opened,
however; if a unit is not connected, the
monitor screen will not display any values.
A unit MUST be connected to open the
Firmware & Logged Data Utility.

Plate 16. Clicking the System
Connectivity Button opens a screen that
provides information on which models
the launch pad is capable of
communicating with, in its presently
loaded state. 

Plate 17. The system connectivity
screen contains a list of modules that
are necessary to be installed in order
to communicate with vintage models.
In the screen above, The earliest
model that this installation will fully
suppor t  has  the  f i rmware
AMTSYS0200 Rev 0. The installation
is only missing the appropriate
configuration and calibration module to
be able to support models with
firmware AMTSYS0111 Rev 2. If it is
necessary to configure or calibrate an
earlier model with this AMTCMF
software version, contact Weschler
Sales for availability of the appropriate
configuration and calibration module. 
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Plate 20. The search will start with the latest
IIE models and, if one is not detected, will
search for earlier IIE then IIR models. When
an Advantage has been detected, the model
type will appear in the model type window.
Note that the model-type text box (upper
center) has been automatically updated.
Once again, It is unnecessary to manually
select a model  type when connecting to a
unit. The software will automatically detect
which model is connected. The model that
was used for this screen is a CT/LTC,
equipped with the optional LCAM module.
For models running AMTSYS0201 rev
4a or 4b firmware only, the detected
firmware revision will be 3a or 3b. This
is intended to allow earlier software to
communicate with rev 4 firmware.

Plate 18. If there is an Advantage IIE
model physically connected to the host,
and you wish to communicate with it, you
must select the unit’s communications ID.
Click the unit ID’s drop-down button, then
scroll to and click on the unit ID. The
factory default unit ID is 00. If the unit ID
has been changed, you will need to read it
from the front panel display. To read the
unit ID from the front panel, navigate to the
COMM SETUP menu item (OMAMT200
figure 14G) and press the ENTER button
until the “ID” prompt and the unit ID number
is displayed. It is not necessary to select
the model type if you are connecting to a
unit. The software will automatically detect
the model type when the correct unit ID is
highlighted and will adjust the model type
text box accordingly.

Plate 19. Once a unit ID is selected, a
search string will appear near the bottom of
the form, showing which ports are being
tested. This screen is normally displayed
for only a few seconds. If the host’s
operating system reports that several ports
are available, the search process may take
longer. If you have inadvertently selected
an incorrect unit ID, click the stop-sign
button to halt the search process, then re-
select the unit ID. When USB-to-serial port
adapters are used, there could be many
available ports. Note that the CMF software
will automatically search for up to 16
available ports. If the host’s operating
system assigns a com port higher than 16,
the port will need to be forced to a number
within the 1 to 16 range. See your adapter’s
or operating system’s instructions regarding
assignment of COM port numbers.
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Plate 21. Communication set ups may be
recalled from the list of previously
established connections, if previous
connections have been saved. This time-
saving feature has been provided for users
who routinely use the same connection. In
some instances the host PC may have
many com ports and the search for a
connected Advantage unit may take
several minutes. By saving the parameters
from a previously established  connection,
the connection can be re-established
instantly. To specify a previously
established connection, click the  saved
connections drop-down then the
appropriate saved connections name.

Plate 22. Communications profiles can be
saved in two ways. The first method is by
using a previously established connection.
To save a communications profile using
this method, first establish a connection,

Figure 23. The save connections dialog
screen will open when the floppy disk
button is clicked. Click the Cancel button
if you are just browsing the stored
connections, or you do not intend to save
a file. The Ethernet connections window
on the bottom will be supported later in
2011.
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Plate 24. If you want to save the
connection, enter a name in the cell
with the “Enter Connection Name”
text, then click the apply button. 

Plate 25. The name of the saved profile will
now appear in the saved connections drop
down menu.

Plate 26. Files may also be created
manually and saved. Click the saved
connections drop down arrow, then click
the “Add, Delete or Edit Entries” menu
item.
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Plate 27. Next click the New button.

Plate 28. A new line will appear which
can be named and edited with the new
communications parameters.

Plate 29. When all of the parameters have
been edited, click the Apply button to
accept the settings
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Plate 31. Clicking the Monitor and Relay Test
Application’s launch button will open the main
monitoring screen. If a unit is connected,
values will begin to fill the table cells. If a unit is
not connected, the table cells will be blank.

Plate 32. The main monitoring screen shows the titles of measured quantities and nine columns of corresponding static
and dynamic values. The connected unit depicted is a CT/LTC model equipped with an LCAM module. The “Sense Fail”
title is a special case that is not displayed on the front panel, but is included here to show the status of any alarms that are
assigned to it. The “Differential Temp” value that is returned here is the filtered differential. The “Deviation” value is the
change in differential since the initial differential value was set. Refer to OMAMT200 for more details on these values. The
“Set Points” column shows any set point values for the alarm source identified by the title name. The “Active Alarm(s)”
column shows which alarms have been assigned to the alarm source. The “Assigned Relays” column shows which relays
are driven by the active alarms. The “Alarmed Relays” column shows which (if any) relays are actually in the alarm state.
The “Peak” and “Valley” columns are self-explanatory. The value of peak and valley data that is stored in the Advantage
(Connected Unit Column) and that is being monitored in real time (Monitor Session column) can be reset individually. To
reset the existing peak and/or valley value, place the cursor over the value and when the value changes to a reset button,
click it. The button text will then change to “confirm” in order to be sure you want to reset the value. Click again to confirm
the desire to reset the value. Resetting a value in the “Connected Unit” column has the same effect as resetting the
corresponding value from the front panel. The “Refresh Rate” text box allows for adjustment of data retrieval rate; from 1
sample per second to 1 sample in 10 seconds. The “Pause” button pauses sampling and the wrench button retrieves new
configuration settings. The Winding 1, 2 and 3 LOL (Loss Of Life) rows show remaining and expended life in hours, and
the aging rate. The Winding LOL will only appear if the option has been authorized and there is a measured winding
temperature for the winding. Winding temperature can be measured by a CT series model or a non-CT model using a
heated thermowell. To exit the monitor module, click the exit door button or the red “X”.

Plate 30. The new connection name will appear in
the saved connections drop down menu.
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Plate 34. Clicking the “AUX INPUTS” tab
shows the values being measured by the
optional LCAM module inputs. If the
LCAM module is not installed, or its
inputs are disabled, only the title bar (no
cells) will appear. The LCAM module’s
measured quantities are not logged, but
they are available to operate alarms and
alarm relays and the values and alarm
status can be transmitted through the
Weschler simple ASCII Protocol (SAP),
DNP-3 or ModBus. 

Clicking the File > Save
Logged Data menu item (left)
pops up a standard file save
dialog. The default directory is
presented (right), but any
directory can be used. All data
values that were logged during
the current monitoring
session are saved. Clicking
the File > Print menu item (left)
will print a  matrix similar to the
main monitor screen. 

Plate 33. Clicking the Options menu item (upper left)allows for selection of
graphics display options. See section 7 for more on graphics display. Clicking
the About menu item (upper center) pops up the monitor module descriptive
information screen (upper right).
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Plate 36. Clicking the relay test tab shows the relay configuration, status and test screen. If a relay is not enabled, it
will not appear in the list. The buttons at the right side of the form provide for a method of testing relay circuit function.
If relay check is not enabled, the relay’s test buttons will not appear. To run a relay test, click the time interval drop-
down button, scroll to and click the desired test interval (30 seconds to 10 minutes) then click start. Once the test is
running the energize or de-energize radio buttons can be clicked to pick-up or drop out a relay. If a relay is in an alarm
state and it is selected for test, it can be dropped out of the alarm state by setting the radio button to the opposite state.
The test can be aborted at any time by clicking the stop button, or the test will stop automatically at the expiration of
the run period interval. If communications are lost before the test interval expires, the relay will still resume its
appropriate state, under local control, when the test interval expires.

Plate 35. Clicking the “ALARM
CONFIG” tab changes to the alarm
configuration screen. This screen
provides detail of the settings made for
each alarm. Two alarms can be viewed
at a time. To view an alarm’s settings,
click the alarm number drop-down
button and then click the desired alarm
number.
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Plate 37. The insulation life tab provides a calculator which allows the user to enter varying winding
temperature and/or time at temperature values to see how the insulation life is affected. Click in the values
on the left window and either scroll to or enter the desired value directly. 
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Plate 40.  If you have a stored
configuration file which is to be opened,
click the File menu item to activate the
drop-down, then navigate to the desired
file using standard Windows file open
techniques. If the file you want is listed on
the previously opened file list (below the
“exit” menu item), click the filename to
open it.

Plate 38. The Configuration and Calibration module
is started by clicking its launch button. The wrench
depiction on the launch button must be in focus
(have a dark outline) in order to launch the module.
Either a communications ID OR a model must be
selected in order to focus the button. If a unit is
connected, select the communications ID. If a unit
is not connected, select the model type. You do not
need to select a communications ID AND a model
type.

Plate 39.  The configuration main-screen opens. If a unit is
not connected, a default configuration file, appropriate to the
model highlighted in the model type selection box,  will load
into the configuration list window. If a unit is connected, the
configuration file is downloaded and displayed as a text matrix
automatically. A message appears momentarily while the file
is being downloaded. The file download normally takes less
than 5 seconds at a data rate of 57600 bits/second.
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Plate 42. To begin the configuration
process, click the Alarm/Retransmit menu
item on the Advantage Parameters pull-
down menu.

Plate 41. The configuration file is downloaded automatically when the configuration
module is opened, but at any time if you need to download the file again, you can
do so by clicking the Retrieve Data menu item on the Communications drop-down
menu.

Plate 43. The Options Enable / Disable screen will appear. On this screen the various functions and hardware are enabled
or disabled. It is advisable to enable only those functions that are needed immediately or that will be needed in the near
future, in order to limit the number of set up items that will be presented in subsequent set up screens and on front panel
displays. Items can be easily added later if necessary by simply reconnecting to the unit with the AMTCMF software. If, on
the other hand, there is the possibility that a unit will need further configuration in the field, without the benefit of the
AMTCMF software, it is advisable to enable whatever items are anticipated to be required, since, with the exception of LTC
function, display viewing and title selection, none of the above items can be enabled or disabled without the software. The
titles for RTD channels 1, 2 and 3 are selected as well as enabled for viewing, in this screen. If a title is set to “Off”, you
cannot enable it for display (upper right-hand inset) Once a title is selected, display of the title on the front panel can be
enabled (middle right-hand inset). Some models (DC shown in lower right-hand inset) have a quite extensive list of available
titles, since the channel function is independent of other functions. See the owners manual for details regarding channel
title selection.

Note that the action buttons on the lower part of the screen will not become enabled unless a parameter is changed. The
“OK” button writes changes to the configuration file and closes the screen. The “EXIT” button simply closes the window
when no changes have been made. The “APPLY” button writes changes to the configuration file, but leaves the screen
open. The “RESTORE” button reverses any changes made since the screen was opened OR since the APPLY button was
clicked.  See owner’s manual OMAMT200 for details on setting of these parameters.
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Plate 44. The next step is to set up the relays.
The relay set up dialog screens can be opened
at any time. Click the Advantage Parameters > 
Relays menu item and the screen to the right
will appear. For CT-series models it is especially
important that the connected equipment be
selected at this time, in order to reduce the
number of options that will be presented in the
transformer parameters set up screen.

Plate 45. Continue configuration by clicking the “System” menu item on the Advantage Parameters drop-down menu.
The parameters on this screen are those used by the Advantage operating system to fit its functions into the user’s
monitoring preferences scheme. Not all models will show all of the options shown here. Values are changed by clicking
in the value text box, then either typing in the new value or scrolling to it. In the right-hand screen-shot, the action buttons
became focused (enabled) when the Delay parameter value was changed. Compare the action buttons on this plate to
the action buttons on plate 51. Note that the EXIT button from that window has changed context to a Cancel button, once
the Delay parameter was changed. This subtle name change will allow for closing the screen without writing any changes
to the configuration file.
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Click in the text window for the desired value and either type in the new value or scroll to it. The Operate Relay selection
is made by clicking the arrow to drop down a list, then click the desired relay on the list. If the relay that is selected has
not yet been configured, the relay set up screen of plate 48 will open when the “OK” or “Apply” buttons are clicked. If the
relay has been previously configured, the relay set up screen will not open automatically. If you want to open the relay
set up screen at any time after a relay has been selected, simply click the button with the relay symbol.

Plate 47. The next step in
configuration is to set up the
alarms. Click the “Alarms” menu
item. The alarm set up screen will
open. To select an alarm, click
anywhere in the line for the desired
alarm.

Plate 46. If the model being configured is a CT-series (CT, CTX or CT/LTC) type, you will want to tailor the Winding
Temperature Algorithm (WTA) to the transformer being monitored. Click the Transformer menu item on the Advantage
Parameters drop-down menu to open the Transformer Parameters screen. If you do not have a CT-series model, you
can skip down to plate 47. The Transformer screen contains parameters that describe various performance
characteristics of transformers. The parameters provide values that the WTA uses to dynamically calculate winding
temperature. The right-hand example screen above depicts a CT-Series model equipped with an LCAM module that
provides three load current signals for calculating the winding temperatures of three distinct windings. The parameters
here are covered in detail in the “keystroke-by-keystroke guide to set up” section in the owner’s manual OMAMT200.
See “Prompt USER” in the keystroke-by-keystroke guide. Prior to any value entry, the required parameters have the word
“change” printed in red, as a guide to which values must be entered for proper WTA  function. Other values will contribute
to the accuracy of the WTA function and should be entered. The Core & Coil Weight and Fluid Capacity entry boxes have
automatic units converters. Simply click the appropriate radio knob next to the desired units, then enter the numeric value
that corresponds to those units. 
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Plate 48. When the relay set up button
on the alarm set up screen is clicked, an
individual relay set up screen opens.

Plate 49. If the model being configured is equipped with an LCAM module and its auxiliary channels have been
enabled, the LCAM Alarms menu item will be in focus (available) for selection. If the model is equipped with an LCAM
module, but its auxiliary channels have not been enabled, the LCAM Alarms menu item will be greyed out. Clicking
the menu item when it is in focus will open the LCAM alarms set up screen. Reference the OMAMT200 owner’s
manual for details regarding individual parameter settings. Select an alarm to set up by clicking anywhere in the line
that the alarm appears on. This screen works the same as the standard alarm set up screen, although the ranges are
electrical rather than thermal and thresholds replace set points. The Relay Association selection presents a unique
feature of the LCAM firmware. When a relay which is driven from another alarm source is associated with an LCAM
alarm, the LCAM alarm will not be activated (armed) until the associated relay switches into its alarm state. This
powerful feature is discussed in the OMAMT200 operators manual in the keystroke-by-keystroke set up guide under
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Plate 50. If your model is equipped with the analog retransmit feature, and it is enabled, the Analog Retransmit menu
item  will be in focus (available) from the Advantage Parameters drop-down menu. If your model is equipped with a single
channel retransmit, only channel 1 will appear. If your model is equipped with a multi-channel analog retransmit (MCAR)
module, up to 3 channels will appear. The Analog Retransmit Setup screen offers parameters for setting the magnitude
of the output signal current which corresponds to the measured quantity (temperature, load current etc.) and for selecting
the source to which the output signal will respond. When setting LTC differential full scale temperatures, you must enter
the value as a positive number, even though a differential temperature which is increasing in magnitude is typically getting
more and more negative.

Plate 51. The last item on the Advantage parameters drop-down menu is Calibration Tables. This feature is not a true
calibration function, but is rather a method of storing the present state of calibration for all inputs that have tabular
calibration data. The screen at the right, showing the inputs with tabular calibration data, will open when the menu item
is clicked. This feature allows for safe external storage of the state of calibration in the event that the calibration stored
internally is inadvertently compromised.
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Plate 52. Click the Load menu item under the file
drop-down to retrieve a saved calibration. The Open
file dialog screen will open to allow for selection of
the calibration file. The file is in txt format. 

Plate 54. After all parametric edits are completed, the file can be uploaded to the Advantage by clicking the Send Data
selection under the Communication menu. Prior to starting the upload process, the software looks to see if the
Advantage has a stored password other than 0 (zero). If the password is 0 the file will be immediately uploaded. If the
stored password is other than 0, a Login prompt dialog (upper center) will appear requesting the password. If the
password is correct the file will be uploaded, but if it is incorrect, an additional Login prompt dialog (upper right) will
appear. You must enter the correct password in order to upload the file. Just prior to upload the warning dialog (lower
left) will appear to give users the opportunity to cancel the upload. Click Yes to proceed or No to cancel. Once the file
has been successfully uploaded, the Command Executed message box (lower right) will momentarily appear.

Plate 53. Click the Save menu item under the file
drop-down to save the calibration. It is advisable to 
name the file such that the appropriate calibration
file will be restored to the corresponding
Advantage if restoration becomes necessary.
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Plate 55. Clicking The “Set Time” menu item on the Communication drop-down transfers the PC clock’s time and date
to the Advantage. Simply click the menu item and the time and date will be sent. Once the time and date have been
sent the confirmation message (above right) will be momentarily displayed.

Plate 56. The “Clear Peak/Valley Memory” menu item, on the Communication drop-down, has been given more
functionality and has been moved to a more convenient location on the Logged Data Utility screen. See plate 32 for
details.

Plate 57. The “Clear Accumulated Relay Time” menu item erases the memory that contains the total time that each
relay in a sequencing arrangement has been in the alarm state. The time is used by the sequencing function to even
out the on-time of same-type cooling apparatus. Once the time has been cleared the confirming message (above
right) will appear.
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Plate 58. The LCAM module is factory calibrated and should not need re-calibration unless calibration of a non-linear
signal is required or, more rarely, a component in the circuit is changed. The LCAM module is calibrated by applying
signals to the inputs, and storing error values in calibration tables. Thus when you calibrate a numbered channel you
are entering values into a table of the same number. See plate 51 for a visual example of calibration tables. Start by
clicking the LCAM Table Calibration menu item below the Communication drop-down. The password Login dialog will
appear. Enter the correct password, then click OK to gain table access. If the wrong password is entered, the warning
dialog (upper right) will appear. The password can be obtained from Weschler. Call 440-238-2550.

Plate 59. The LCAM calibration screen will open. Start by
selecting which calibration method will be used. Selecting
“Manual” initiates a standard calibration as described in plate
57. Selecting “From Configuration File” restores a calibration
table from a calibration that was previously stored to an
external memory device, such as was explained in plates 52
and 53. Selecting “Restore Factory Calibration” restores the
calibration that is stored in the Advantage memory from the
initial calibration that was performed in the factory. The next
step is to select which channel(s) will be calibrated. The
choices will correspond to the signal assignments that were
made in the Options Enable / Disable screen (plate 81). If more
than one channel is being calibrated  to the same value, current
signals may be applied to the inputs in series and voltage
signals may be applied in parallel and the channels can be
calibrated simultaneously. For example, in the screen to the
left, selecting the check boxes for Winding 1 Current and
Winding 2 Current while applying the current signal to both
inputs in series, will calibrate both channels simultaneously. 

Plate 60. As soon as the channel is selected, brief
instructions will fill the window at the top of the LCAM Table
Calibration screen. The calibration will always start with point
1, which is the smallest signal in the range. Apply the
indicated signal to the channel input(s), then click the Apply
button. In the example to the left, the channel being calibrated
is on an LCAM module in a CT-series Advantage, with
channel 1 as a dedicated winding current input and channels
2 & 3 assigned to winding current. The operator has chosen
to calibrate channel 1 independently of the other channels.
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Plate 62. When you click next, after calibrating the
eighth point, the calibration will be complete and the
dialog box will change to that shown in plate 64.

Plate 64.  The calibration finishes when the Next
button is clicked after the last point is calibrated.

Plate 61. There are 8 calibration points in the table. After
applying the Point Value signal, click the Apply button to
store the value, then the Next button to move to the next
point. The bargraph will advance as subsequent points are
calibrated. At any point in the table, not including the first
(0.0 amps AC in this case) and last (10.0 amps AC in this
case) you can adjust the point value. This capability is
used only when calibrating for a non-linear signal. In this
and most other cases, the factory point values should be
used.

Plate 63. If all of the auxiliary channels have the
same input range they may also be calibrated
together. In the examples to the left, selecting either
of the two LCAM channels locked out the other for
simultaneous calibration, because the input signal
sources are not the same.
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Plate 65. The next calibration item is the thermal (RTD input) channels. Click “RTD Table Calibration” under the
Communication drop-down . The Login password dialog will open. Enter the correct password to gain access to the
thermal channel calibration screen. If the wrong password is entered, the warning dialog (upper right) will appear. The
password can be obtained from Weschler. Call 440-238-2550.

Plate 67. Clicking on one of the calibration method radio
knobs enables the channel selection check boxes. 

Plate 66. Once the correct password is entered, the RTD
Table Calibration screen will appear. The thermal input
channels are calibrated very similarly to the LCAM
channels. The main difference is that the RTD input signal
is a series of standard resistances that correspond to 
predetermined temperature values. The need to calibrate
is rare, and it is recommended that only experienced
technicians perform calibration operations. Depending
upon which model you have, there may be up to three
channels. Begin by clicking on the desired calibration
method. Selecting “Manual” initiates a standard calibration
as described in plate 59. Selecting “From Configuration
File” restores a calibration table from a calibration that was
previously stored to an external memory device, such as
was explained in plates 52 and 53. Selecting “Restore
Factory Calibration” restores the calibration that is stored in
the Advantage memory from the initial calibration that was
performed in the factory.
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Plate 69. Wait a couple seconds, then click the Apply
button. This will cause the Advantage to store the 
calibration value.

Plate 70. When the calibration point is accepted, the ‘OK,
Command Executed” message will appear. Click the “Next”
button to advance to the next calibration point.

Plate 71. The Point 2 calibration screen appears, with the
values for point 2. Adjust the standard resistance decade
or RTD simulator for these values. The temperature and/or
resistance value can be changed if it is desired to calibrate
to an RTD probe with a non-standard resistance curve.
CAUTION! The appropriate resistance and its
corresponding temperature equivalence must be supplied
in order to ensure accurate calibration. 

Plate 72. The bargraph will advance as subsequent points
are calibrated. There are 12 calibration points in the
standard RTD tables. The number of calibration points may
be reduced, but it will negatively effect accuracy and is not
recommended. 

Plate 68. After selecting the calibration method and channel
to be calibrated, the input values for the first calibrated point
appear. The calibration values can be browsed up and
down through the calibration screens without calibrating the
points by simply clicking the “Next” and “Back” buttons. If
you are just browsing, close the screen when you are done
by clicking the “Exit” button. If a calibration is being
performed, set your resistance standard to the indicated
resistance or set your RTD simulator to the indicated
temperature.
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Plate 74. Click the Analog Retransmit Calibration
menu item under the Communication drop-down
to initiate the retransmit output calibration
procedure. This procedure offers four methods of

Plate 73. After calibrating the last
point, when you click the Next
button, the calibration is
completed. Click the Exit button to
end the RTD table calibration
procedure.

Plate 75. Selecting the “Factory Coefficient -Milliammeter”
method initiates the calibration procedure most commonly
identified with laboratory calibration methods..

Plate 76. Select a channel to calibrate. Connect a
standard DC milliammeter to the channel output that is to
be calibrated and set the sensitivity to the next highest
range above 25 ma. Connect the appropriate source
standard to the source for the analog retransmit. Adjust
the source standard signal for the endscale of the
retransmit source.

Plate 77. Set the value in the “Readings” text box equal
to the indication on the standard milliammeter. Click the
Apply or OK button. The Advantage will automatically
calculate and store the appropriate factory coefficient. 
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Plate 78. “The Factory Coefficient - Direct Entry” method
is used when the factory coefficient is known, such as will 
be the case if an older unit is being upgraded to
AMTSYS0201 / AMTCMF0201 firmware / software. The
coefficient(s) for older models is printed on a label affixed
to the inner side wall of the case in the lower case cavity.
All that is required to use this method is to enter the
coefficient(s) from the label into the Factory RTX
coefficients text boxes  as shown in the illustration to the
left. Click the Apply or OK buttons when finished.

Plate 79. The “User Coefficients - Remote Reading”
method is typically used during commissioning to
compensate for data acquisition systems that have loop
errors that cannot be easily compensated for elsewhere. 
Set the source for the retransmit channel to an on-scale
value. Contact the remote site and determine what the
value is, that is being indicated by the remote instrument. 
Adjust the value in the User RTX coefficients text box until
the remote display indicates the same value as the
Advantage display. Click the Apply or OK buttons when
finished.

Plate 80. The “ User Coefficients - Direct Entry” method
is similar to the method of plate 78, but it uses a
calculation of error as a percent of reading for its entry.
This method is useful if a remote site can calculate and
record an observed error, but cannot communicate it
instantly as in plate 78. The error can be compensated
up to ± 5% of the reading.
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Plate 82. Clicking the “About” menu item pops up the
about information box. This box provides software
version and usage information.

Plate 81. The Options drop-down menu is provided to allow users to define preferences for on-screen warnings and 
text display. Simply click the option to enable or disable the preference. The “Report Required Parameters”
preference either enables or disables pop-up windows that warn of missing or out-of-range required values. The
“Require Cooling Equipment” preference either enables or disables pop-up windows that warn of missing cooling
equipment specification(s) in the relay’s connected equipment parameter. This applies mostly to CT series models.
These pop-up  windows may be annoying in the early stages of set up when they may appear frequently as settings
are applied, however; the warnings provide a valuable aid to completing set ups properly the first time. It is
recommended that these options be enabled prior to sending configuration data to the unit. The Display
Configurations preference either shows or hides the set-up text matrix in the main display window. The “Save
Calibration Tables on File” option includes calibration table values in the configuration file. This is useful when careful
control is exercised to make sure configuration files are not used on multiple Advantage models where calibrations 
can become cross contaminated from unit to unit. It is advised if this option is used that the configuration files have
part of their filenames encoded with a password and that the password be used for front panel supervisory access.
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4.0 Installing New Firmware

Introduction

The Advantage IIE has the capability of having its firmware replaced by rewriting the memory with new program code. The
program code is stored in a type of non-volatile memory called flash memory, and the process of rewriting the program code
is referred to as flashing the memory. The AMTCMF0202 software has a firmware flashing capability built-in. The actual
program code is a text file which is typically less than 1 MB in size

Process Description and Preparation to Flash

Memory flashing traditionally has been jokingly referred to as a “plug-and-pray” operation because of the risk of overwriting
the firmware with corrupted data and thus requiring a trip to the factory for correction. The Advantage is equipped with
redundant memory systems and error checking algorithms which make the file transfer safe and reliable. In order to ensure
reliable firmware transfer, the new firmware must be uploaded using the AMTCMF0202 firmware upgrade utility only.
Despite provisions to insure the reliable transfer of firmware, it is strongly recommended that users download and save the
configuration file with the calibration tables included. To enable saving calibration files within configuration files, refer to plate
81 above. The only other precaution is to ensure that the power source be absolutely reliable throughout the process. If
power fails during the programming phase it may render the unit unuseable.

The new firmware is uploaded by connecting a serial com port of a computer to the Advantage port 1 receptacle using an
RJ11 (6P6C) to DB-9 adapter and a six conductor flat telephone cable. The port 1 receptacle is located behind the
Advantage’s terminal access cover plate. To remove the cover plate, unscrew and remove the two bottom screws, then
loosen the top screws four or five turns and slide the plate off. See figure 1 (flush-mount) or 2 (panel-mount) of owner’s
manual OMAMT200 for an illustration of the actual location of port 1. 

The cable and adaptor are supplied as part of the communications option package, and additional cables and adapters can
be ordered from Weschler. The cables come in two standard lengths; 10 feet, part number 600000726 and 14 feet, part
number 6000000727. The adapter is part number 2100000101. The cable and adapter can be purchased as an assembly;
10 feet, part number 1000001701 and 14 feet, part number 1000001703.

Prior to initiating the flash procedure, the communications parameters will need to be set up, from the front panel keypad.
Referring to figure 14G of OMAMT200 Rev 6, enter the COMM SETUP loop and set the unit ID (Prompt “ID”) to match the
unit ID you will use while running the software. The default unit ID is 0, and if there is no reason to change it, we recommend 
it be left at 0. No other communications settings are necessary.

The firmware upgrade is a two or three step process depending upon which firmware you are upgrading from. There are
three types of upgrade scenarios possible. The conditions are based on the version of firmware and the type of flash
memory the unit is fitted with. Before starting to upgrade, review the existing conditions in the table below and upload the
listed files in the order they appear. Each file is uploaded following the same process as firmware files. 

Existing Conditions File Names (minus revision & date code) and Upload Order

Firmware prior to AMTSYS0200.
Memory is old flash.

AMTUPG0103 (old flash)
AMTBTL0103 (old flash)
AMTSYS0202 (old flash)

Firmware AMTSYS0200 or
AMTSYS0201.

Memory is old flash.

AMTBTL0103 (old flash)
AMTSYS0202 (old flash)

Firmware AMTSYS0200 or
AMTSYS0201.

Memory is new flash.

AMTBTL0103 (new flash)
AMTSYS0202 (new flash)
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Plate 84. The Firmware Upload utility
screen will open. The top window shows
details of the download and the bottom
window shows progress. To begin the
download, click the “Send Firmware”
button. This action will send firmware and
bootloader files. As soon as the button is
clicked, a File Open dialog (plate 85) will
open.

Plate 85. Navigate to the desired firmware
and open it by double clicking the filename.
In the example to the left, the user is
upgrading AMTSYS0200 firmware to
AMTSYS0202 in a unit with new flash
memory. In reference to the table on page
3 0 ,  A M T B T L 0 1 0 3 _ r e v B _
20101207_1407_New flash would be
uploaded first, followed by AMTSYS0202
_rev1B_20110106_1230_Newflash.  As
soon as the file is opened it will begin the
loading process (plate 86).

Plate 83. To begin, make sure you are
connected to the desired target unit,
then click the “Firmware Update”
button. See plates 14 and  18 - 20 for
instructions on connecting to a target
unit.
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Plate 87. As the loading process finishes, the
file is subjected to another integrity check which,
if successful initiates flash memory  erasure.
Following flash memory erasure the new
firmware is written to flash in the programming
process. After the flash is written, the file is
subjected to a third integrity check, and if
successful, initiates an initialize and reboot
sequence. When the whole process is
completed the upper screen reports on the
versions of firmware and bootloader that are
loaded. The bottom screen simply reports that
the process is completed. The Advantage front
panel displays status words in the sequence
ERASING, PROGRAMING, WAIT-INIT,
REBOOTING, AMTGXT0201 and finally the
lamp test display.

Plate 86. The Advantage will do initial file
integrity checks and if the file passes will
begin loading the file into its memory. The
upper screen reports the operations that are
being performed and prints an asterisk (*)
after each line of the firmware file is sent. The
lower screen reports the estimate of total
time to perform the upload and how much
time has elapsed since the upload began.
The Advantage front panel display will show
a series of status words, while the upload is
progressing. During the upload process the
status word “LOADING **” will be displayed. 

Plate 88. The Firmware Upload utility also includes
a facility to send discreet commands to the firmware.
Discreet commands typically perform a single action.
They are composed in the form of text files, with
special formatting. To send a command, click the
Send Command button.
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Plate 89. A standard Windows file open dialog will
open allowing for navigation to the command file.
When the file is located, either double click on it or
click to select it then click the Open button to send the
command file. After the file is sent, It wil be
acknowledged with the message above. 

Plate 90. The Upload Firmware utility has two
more command buttons. The Clear All button
erases all text from the upper and lower
windows and the Exit  button closes the
Firmware Upload screen. 
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Plate 91. Connect to an Advantage using the
procedure of plates 18 - 20. It is advisable to
set the data rate (baud) to the highest that the
host PC can tolerate since the logged data
files may be quite long. Click on the Launch
pad’s Logged Data Utility button and the
Logged Data Utility screen will open. Click the
Request P&V button to initiate the download.

Plate 92. A few message boxes will appear very briefly,
followed by the Receiving Logged Data message box,
which will show the progress of the download. Files
which cover an extended logging period will take a
significant period of time to receive and sort.

5.0 Downloading Historical Peak and Valley Values

Plate 93. The data will be sorted and presented in the
data window. The Clear Window button, as its name
implies, clears the data from the window. Be patient,
since there may be a large file to sort.
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Plate 94. Clicking the Clear Window button removes
the log file from the screen and PC memory, but not
the Advantage’s memory. The Delete P&V History
button erases the stored peak and valley logs from the
Advantage memory. The peak and valley data is
typically cleared prior to entering a long period of new
logging activities. Caution! once the peak and valley
data has been deleted, there is no way to retrieve it. If
it is desired to retain the old logs, they must be saved
to a file on the PC prior to deleting them. Once the logs
are deleted a confirmation message will appear

Plate 95. Tables from previous logging periods can be merged to form a larger file, if the earlier file has been saved using
this utility. The file save procedure is a standard Windows process, using the “Save Log File” menu item under the “File”
drop-down, as shown above left. To begin a file merge, navigate to and open the saved log file.

Plate 96. The saved log file will open
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Plate 97. Clicking the Request P&V button will initiate a file download from the logs that are stored in the
Advantage memory. The utility will open a message box asking if you want to merge the files. Click yes and the
downloaded file will be appended to the end of the file that was opened from PC memory. The dates and times
will be adjusted as if the log was from a continuous session. 

Plate 98. Once a log file has been
downloaded or opened, the data can be
graphically represented by clicking the
Graphics tab above the window. Click in the
checkbox next to any quantities that are to
be plotted. The Clear button will clear the
graphics screen AND the data. 

Plate 99. The graph can be zoomed by left-
clicking and dragging the cursor across the
area of interest to form a window.
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Open your favorite word processor program and browse to the peak and valley text file. You may use almost any word
processor which is capable of displaying text files. If the file is fairly short, it may be opened in Notepad. The extension of
the saved peak and valley files is “log”, so when opening the file you should set your file type to “all files”.  The file below
is an example of the portion of a peak and valley file which contains logging of 4 peak values for winding 1 current and 4
peak values for winding 2.

005,2007,10,12,08,00,00,10
005,2007,10,12,09,00,00,5
005,2007,10,12,10,00,00,4
005,2007,10,12,11,00,00,4
006,2007,10,11,13,25,42,10
006,2007,10,11,14,30,16,72
006,2007,10,11,16,00,00,72
006,2007,10,11,17,00,00,72

The data file is constructed in simple comma delimited ASCII with a carriage return at the end of each event record. Data
items are separated by commas. This file configuration can also be loaded by popular spreadsheet programs such as Corel
QuattroPro and Microsoft Excel.
    

The first data item in each event record is coded to indicate the type of event record. The codes are as follows:
    
0 = Thermal Channel 1 Peak Temperature
1 = Winding 1 Peak Temperature (CT series only)
2 = Winding 2 Peak Temperature (CT series with LCAM, with LCAM channel 2 configured for winding current input)
3 = Winding 3 Peak Temperature (CT series with LCAM, with LCAM channel 3 configured for winding current input)
4 = Highest Winding Peak Temp (CT series with LCAM, with more than 1 channel configured for winding current input)
5 = Current 1 Peak (CT series only)
6 = Current 2 Peak (CT series with LCAM, with LCAM channel 2 configured for winding current input)
7 = Current 3 Peak (CT series with LCAM, with LCAM channel 3 configured for winding current input)
8 = Highest Current Peak (CT series with LCAM, with more than 1 channel configured for winding current input)
9 = Thermal Channel 2 Peak Temperature (in LTC and CT/LTC models, LTC Tank Peak Temperature
10 = Thermal Channel 3 Peak Temperature
11 = LTC Differential Temperature Peak

128 = Thermal Channel 1 Valley Temperature
129 = Winding 1 Valley Temperature (CT series only)
130 = Winding 2 Valley Temperature (CT series with LCAM, with LCAM channel 2 configured for winding current input)

Plate 100. When the mouse button is
released, the zoomed portion of the plot will
expand to fill the window. The “hover help”
data box shows the value of the signal and the
time of occurrence when the cursor is held
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131 = Winding 3 Valley Temperature (CT series with LCAM, with LCAM channel 3 configured for winding current input)
132 = Highest Winding Valley Temp (CT series with LCAM, with more than 1 channel configured for winding current input)
133 = Current 1 Valley (CT series only)
134 = Current 2 Valley (CT series with LCAM, with LCAM channel 2 configured for winding current input)
135 = Current 3 Valley (CT series with LCAM, with LCAM channel 3 configured for winding current input)
136 = Highest Current Valley (CT series with LCAM, with more than 1 channel configured for winding current input)
137 = Thermal Channel 2 Valley Temperature (in LTC and CT/LTC models, LTC Tank Valley Temperature
138 = Thermal Channel 3 Valley Temperature
139 = LTC Deviation Temperature (also known as LTC Differential Valley Temperature)
470 = State of power to the Advantage. Applies a time and date stamp to when power failed and was restored.
    
The split in coding between 11 and 128 allows for a future total of 128 peak and 128 valley categories.
 
The second, third and forth data items are the year, month and day that the event occurred.

The fifth, sixth and seventh data items are the hour (in 24 hour format), minute and second that the event occurred.
   
The eighth and last data item is the actual reading in decimal representation. Note that all thermal values are assumed to
have one decimal place, thus the 950 in the data string below represents an actual measured value of 95.0 degrees C.
Current values are transmitted directly, thus a value of 1000 in a code 5 data string would be an actual current peak value
of 1000 amps.

004, 2007, 10, 02, 14, 23, 36, 950

As an example, the data string above indicates that a hottest winding temperature peak event occurred on October 2nd 
2007at 14:23:36 hours and the peak temperature was  95.0 EC.

The code 470 (power state) data string is filled the same as the other data elements, but the value is fixed at 0 (zero) for
a power fail and 100 when power is restored.

The AMTCMF0202 data logging utility performs a special data padding operation when the data is retrieved and sorted.
The data logging is not performed at regular intervals, but rather is recorded at the time when a peak and valley occurred
during each elapsed hour. If the value being logged remained constant throughout the hour, the value will be recorded at
the last second of the hour. Because a peak or valley for any specific value may occur at any time, values for the other
quantities being logged must be provided at the same instant of time in order for analysis and charting software to interpret
the data properly.  The AMTCMF software determines the approximate values of the other quantities by interpolating using
the value on the time line that occurred immediately prior to and immediately after the value that achieved a peak or valley. 
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6.0 Physical Layer (Cabling Connections)

There are two ports available for hard wire connections. Port one uses an RJ-11 connector. Port one is primarily
intended for connection of a portable or desk-top computer for on-site configuration of Advantage settings, 
monitoring of transformer conditions and flashing the firmware. The RJ-11 connectors with an appropriate six
conductor extension cable and a RJ-11 to DB-9 (telecom cable to PC port) adaptor is used for this process. The
six-pin RJ-12 must be used with a six conductor telecom cable and the adapter to provide 5 vdc DTR and CTS
signals for some fiber-optic adaptor devices which are port-powered. The current drawn from this port must not
exceed 25 madc, and it must be isolated from EMI / RFI sources.

Port two is connected through the terminal strip on the I/O module. See the terminal assignments diagrams in
the owner’s manuals for terminal numbers. This port does not provide a 5 vdc source for port-powered devices.

The ports are exclusive; meaning that they cannot communicate simultaneously. Port two is the default port,
but if an RJ-11 connector with the adapter attached are plugged into port one, communications will automatically
be switched to port one and port two will be disabled. When the RJ connector or the adapter are removed,
communications will automatically be switched back to port two. In order for this switching to work properly, the
connections diagramed in the Communications Port One Cabling figure 1 must be followed, when adapters are
fabricated in the field. The adapter supplied by Weschler (part number 2100000101) is wired this way. The
adapter is available as an assembly with a fourteen foot, six-wire telecon cable as part number 1000001701.
Shorter cable lengths are available.

It is strongly recommended that only port one, or port two configured for RS-232 operation be used for firmware
flashing. While port 2 has been successfully used in RS-485 mode using carefully controlled  conditions, signal
noise variables associated with long data lines and RS-232 to RS-485 converters can make reliable real-world
firmware flashing a challenge.

Figure 1 Port 1 Cabling
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Plate 101. With the monitor screen
opened, click the “Options” drop-down
then click the “Display Graphics”
menu item to enable the graphics
display. Select which signals to
display by clicking in column G of the
matrix, in the cell that corresponds to
the signal that you would like to track.
A “Y” will appear in the cell if the
signal is being plotted on the graphic.
Click the cell a second time to clear
the signal tracking.

7.0 Miscellaneous Software Features

Monitor Module:

Viewing Monitor Module Data Graphically

The monitor module provides a graphing option that will present plots of selected measured or calculated values in real time.
This is helpful when doing set up operations to visualize what the various signals are trending to.

Plate 102. The plot of the graph
appears at the bottom of the monitor
main-screen.  The graphic will only
appear on the main window. An
additional control box appears in the
“Refresh Rate” frame. The “Graphic”
value allows you to set the update rate
for the graphical data from 5 to 30
seconds. If you place the cursor
anywhere on the graphic plot a hover
dialog will appear indicating the value
of the signal and time of occurrence.
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Plate 105. The “Pause” button stops the software
from polling the Advantage for data. When you
click the Pause button it changes context to a
“Poll” button, which restarts polling for data when
it is clicked. When polling is restarted, a trace is
drawn from the data point that was plotted when
the Pause button was clicked, to the present
value. Intermediate values are not captured when
polling is paused. To restore the normal monitor
screen, double click anywhere on the graphic plot.

Plate 103. To clear the plot and restart at the
present time, click the “clear” button at the lower
right-hand corner of the screen.

Plate 104. If you double-click anywhere on the
small graph, the plot will grow to fill the entire main
monitor screen. The cursor hover dialog works on
this window also.
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Plate 106. The hover dialog works on the larger
graphic, but here are times when signals
overlap and it can be hard to pick out an
individual signal. There is a plot expansion tool
for this situation.

Plate 107. Place the cursor below and to the
immediate left of the beginning of the area that
you want to expand. The cursor must be in the
border area between the X axis scale line and
the bottom edge of the graphic. Left click and
drag  the yellow bar across the area that you
want to expand, then release the left button.

Plate 108. The area that was highlighted will
now expand to fill the width of the graphic. It is
much easier to pick a trace in this way. Be
advised that while you are in this expanded
mode, the traces will not continue to be drawn,
otherwise the pattern you are looking at would
rapidly disappear off of the left  side of the
graphic, as new traces are drawn from the right.
Note that the hover dialog indicates that the time
(X) axis is in the expanded (zoomed) mode. 
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Plate 109. To resume the normal (unexpanded)
graphic, right click anywhere in the bottom border
area where the cursor is shown and themn in the
left border area. Activity that occurred while you
were in expanded mode will be drawn in as if you
never left normal mode, assuming  you were not
in the expanded mode for more time than is
represented by the full width of the graphic. 

Plate 110. The monitor module now provides a
means of artificially accelerating the Winding
Temperature Agorithm. This is handy when
commissioning new transformers or just checking
set point settings. Click the “WTA Speed” button in
the tool row near the top of the monitor screen.
The message box of plate 111 will appear.

Plate 111. The WTA acceleration feature allows the
user to specify how fast the WTA will run, by setting
an acceleration ratio factor related to a real time hour.
In the example at the left, the first number indicates
that 1 hour of real time is compressed into 60
seconds, creating a ratio of 60:3600. The second
number is the acceleration time-out, which is the
example is set to 10800 seconds (3 hours).
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Plate 112. Open the configuration screen and
click the “Edit” drop-down then the “User
Notes” menu item.

Configuration Module:

Adding Notes to Stored Configuration Files

Notes can be added to configuration files that will appear near the top of the first page in the configuration screen and will
print in the same position on hard copy. The notes will be stored along with configuration. In this way users will be able to
store applications information such as the transformer to which the configuration belongs or a unique serial number or the
person who composed the configuration, etc. The notes are limited to a single line (256 characters) of text.

Plate 113. A text box
will open which allows
you to enter the
desired text.

Plate 114. When the text box is closed your note will
appear as a line of text as shown in the figure. The text
will wrap to the next line for each 64 characters
entered. The note is highlighted here for emphasis
only.
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Logged Data Utility Module:

Viewing Peak and Valley Data Graphically

The utility module can display the peak and valley data graphically in addition to its sorting, storing and retrieval functions. 
Using this feature it is easy to identify periods when activity is of particular interest and zoom in to get a more detailed look
at the trends that the data represents. The graphing feature can use data that has just been downloaded or it can use log
files that were previously downloaded and stored for future review.

This feature will only work with log files that were generated by the software and firmware for which this manual was written.
See the cover page for the software and firmware versions covered by this manual.  

Plate 115. If a data file has just been
downloaded, click on the Graphics tab to
display a blank graph. Click in the check
boxes in the right-hand pane to select
which quantities are to be plotted. As
each quantity is selected, it is added to
the tabulation to the right of the plot area
along with the assigned trace color.

Plate 116. Like the monitor module’s
graphing feature, the X and Y axes can
be expanded (zoomed) to view the signal
data in more detail.  Simply click and drag
the cursor in the area below the X axis or
to the right of the Y axis to  highlight the
area of interest. The highlighted area will
expand to fill the whole width of the plot
area. 
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Plate 117. The hover-help can then be
used to pick off the values at any point on
a trace by simply pointing to the point with
the cursor. To un-zoom the plot, right-click
in the margin area below the X axis or to
the right of the Y axis.

Plate 118. To view a stored log file, click
on the File menu then the Open Log File
menu item. A standard windows
navigation dialog box will open allowing
you to find and select the appropriate file.
This feature will not work with log files
created with earlier versions of software.
If an earlier file is opened, a File Format
Error warn box will pop up.
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